MITSUBISHI Electric Corporation
MELSERVO MR-J4 Series
MELSERVO J4 Series Driver

Supported version TOP Design Studio V1.0 or higher {Rl

TOP

"
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We would like to thank our customers for using M2l's "Touch

Operation Panel (M2] TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device".

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 10

‘ Describes how to set up communication for external devices.

5. Cable table Page 11

‘ Describes the cable specifications required for connection.

6. Supported addresses Page 12

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration

The system configuration of TOP and “MITSUBISHI Electric Corporation - MELSERVO MR-J4 Series” is as follows:

Communication Communication

Series ‘ CPU Link I/F

method setting

3. TOP communication

MELSERVO MR-J4-1A CN3 Port setting
) RS-422 ) 5. Cable table
MR-J4 MR-J4-[JA-RJ on CPU unit 4. External device
setting

H Connection configuration

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422/485 communication.

L ==al

+ 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS422/485 communication.
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device [ = |

PLC select [COM2]

Filter - [ [al] ~] Search
@ Model () Vendor
Vendor Model
. A
M2I Corporation (@ MELSEC Q Series

MITSUBISHI Electric Corporation

OMRON Industrial Automation

MELSEC FX Series

MELSEC AnM/AnS Series
LS Industrial Systems
MELSEC AnA/AnU Series
MODBUS Organization
MELSERVO ]2 Series
SIEMEMS AG.

MELSERVO 13 Series

LA A AR

Rockwell Automation

§#  wrsevons
GE Fanuc Automation [ = S

PAMASONIC Electric Works MELSEC FX2N-10/20GM Series

@

YASKAWA Electric Corporation MELSEC iQ-F Series
YOKOGAWA Electric Corparation
Schneider Electric Industries

KDT Systems

RS Autnmation s

4 Eack | B Next ® Cancel

Select Device n

PLC Setting[ MELSERVO 34 Series ]

Alias Name : |PLC1

Interface : | Computer Link w
Protocol ; |Computer Link. ~

String Save Mode ; |First LH HL Change

[ use Redundancy
AND ~

Comm Manual

4r

Primary Option

Decimal Point of POS

Timeout msec
send Wait msec
Station No

4 Back + OK ® Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.
Please select "“MITSUBISHI Electric Corporation”.
PLC Select an external device to connect to TOP.

Protocol

Interface

MELSERVO J4 Series

Please check the system configuration in Chapter 1 to see if the external device you want to

Computer Link Computer Link

connect is a model whose system can be configured.
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3. TOP communication setting

TO,

ERI2 e B X
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP Design Studio.

Project Option

- Change HMI[H]

R Ao PLC ST Change PLCI

t {3 TOP Setting !
B 520X

~13% COM3 (0)

E3 Delete PLCD)

Project Name=New project

-4l Ethernet (0) Start Mode=Menu
Start Screen No.=1
0
m viireless {0) S
-4 USBDevice (0) e

Communication Error Message =0
USBErrorMessage=0
StorageFrrorMessage=1
DatabaseMessage=1

Date [ Time Sync. =~ Screen Option Unit Convert

v - UDW”I:WU‘(& )Setung Project Option ~ Screen Change | HmiSetup | Global Lock & Touch | Project Style  Splash  PLC Buffer Sync.

- FieldBus (0]

-8 RFID (0) Use HMI Setup
v -ig Device Setting

gt Initialization Edit

v 5% CoM2 (1) Project Setting ~
-4 PLC1: MELSERVO J4 Serig HMIDisable=0

Control Panel

System mDevices ?Service _'—'"'.'Dption

mm Serial X
——_ =
| . Serial Port:  COMI -
PLC SECUT ity Dat e/ Time Shemal Levsl
(O) RS-232C (@) Rs-422(4) O RS-485(2)
. Baud Rate: 33400 M
..- 3l —
L it:
Data Bit: |3 ~
Et hernet Serial HOK | .
Stop Bit: |1 -
— Parity Bit: Ewven ~
= ‘\\ Flow: [Off
L aanl Ping
Diagnost ic File Fing Auto Search Loopback Test
Manager
Apply Cancel
Items TOP External device Remarks
Signal Level (port) RS-422 RS-422
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit Even

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
W [Project > Project Property > Device Setting > COM > “PLC1 : MELSERVO J4 Series"]

— Set the options of the MELSERVO J4 Series communication driver in TOP Design Studio.

TO,

ERI2 e B X
Touch Qperation Panel

Project Option

-Change HMITH]

v -3 TOP Setting

-8 RFID (0)
o Device Setting
i--Ig¥ COM1(0)

- aera

""" 4 PLC1: MELSERVO 14 Serig

-l S
-4 Ethernet (0)
i Wireless (0)
.48 USBDevice (0)

Timeout
Send Wait
Retry

Station Mo

W Acd PLC A T Change PLCIC)

Interface :
Protocol

String Save Mode

Primary Option

Dedmal Point of POS

PLC Setting[ MELSERVO 14 Series ]

[ Delete PLCID)

Alias Name : [PLC1

Computer Link

: | Computer Link

£

£

: |First LHHL Change

[] use Redundancy

Edit

Comm Manual

Apply Close
Items Settings Remarks
Interface Select "Computer Link". Refer to "2. External
Protocol Select "Computer Link". device selection”.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP’s receiving a response from an external device and

sending the next command request.

Retry Set the number of request retries when the data request result is no
response/negative response.
Station Num Set the prefix of an external device.

Decimal Point of

Configures the transfer length arrangement of the external device. Must be

POS configured identically to the settings of the external device in order for normal *Note)
writing procedure to occur on the POS address.
*Note) Refer to the user manual of the external device for more details on transfer length arrangement.
) ] Input Scale for Position data
Decimal Point of POS
[mm] [inch]
0 - 999.999 ~ + 999.999 - 99.9999 ~ + 99.9999
1 - 9999.99 ~ + 9999.99 - 999.999 ~ + 999.999
2 -99999.9 ~ + 99999.9 - 9999.99 ~ + 9999.99
3 - 999999 ~ + 999999 - 99999.9 ~ + 99999.9
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3.2. Communication setting in TOP
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

B Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the

main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

Coniktrol Panel

oE Serial
Run = Serial Port: l COM1 “] _
m [ Signal Level
‘ ' O RS-23e ® RS-422(4) O RS-4B5(2) |
PLC Securit
Y Baud Rate: | 38400 |~
YHC Py
. Data Bit: |8 ~|
Yiewer i
.-l
e I Stop Bit: | | -
1 Ethernet Serial
. @B R Sl Parity Bit: | Even -
T R
e Flow: | 0ff ~
Sc;een m % l ‘ ]
t
Sho g ( lAuto Searchl [Loopback Test]
Diagnost ic File
Mariager
y
[System] Close f
|
Items TOP External device Remarks
Signal Level (port) RS-422 RS-422
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit Even

* The above settings are setting examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Main Screen > Control Panel > PLC]

®

@ Systen Driver(COM2) | PLOI(MELSERVO J4 Series) -/
Interface | Computer Link Rd
Protocol | Computer Link Rd
Timeout 300 3 msec
VHC send Wait 0 3 msec
Yiewer [IJ-I"I] Retry 5 =
Fmm=a Il station b o =
] Ethernet
H6° ecinal F
LE N N |
Screen m
shot
Diagnost ic
[System] [ Diagnostic lCanceI]
_4
Items Settings Remarks
Interface Select "Computer Link". Refer to "2. External

Protocol Select “Computer Link". device selection”.

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.

SendWait (ms) Set the waiting time between TOP's receiving a response from an external device and

sending the next command request.

Retry Set the number of request retries when the data request result is no

response/negative response.

Station Num Set the prefix of an external device.

Decimal Point of Configures the transfer length arrangement of the external device. Must be

POS configured identically to the settings of the external device in order for normal *Note)

writing procedure to occur on the POS address.

*Note) Refer to the user manual of the external device for more details on transfer length arrangement.

Input Scale for Position data

Decimal Point of POS
[mm] [inch]

- 999.999 ~ + 999.999

- 99.9999 ~ + 99.9999

- 9999.99 ~ + 9999.99

- 999.999 ~ + 999.999

- 99999.9 ~ + 99999.9

- 9999.99 ~ + 9999.99

w I [ = O

- 999999 ~ + 999999

- 99999.9 ~ + 99999.9

External device connection manual for TOP Design Studio

7/ 13



TO BRI HE B X
Touch Qperation Panel

3.3 Communication diagnostics

W Check the interface setting status between the TOP and external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the port (COM1/COM?2) settings you want to use in [Control Panel > Serial] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
' . ) 1. System configuration
configuration Connection cable name oK NG
TOP Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
. . oK NG . ;
diagnostics 3. Communication setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module
OK NG
name)
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings oK NG 4. External device setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

TO BRI HE B X
Touch Qperation Panel

+ The serial communication parameter of the “MELSERVO MR-J4 Series” is configt

"Push button switch”.

+ Reboot the external device after configuration.

For a more detailed setting method than described in this example,

refer to the user manual of the external device.

B Communication Parameter Settings for MELSERVO-J4 Series

Push button

switch

Items

Parameter

Descriptions

Prefix number

setting

Basic  parameter
[Pr.PC20]

0 (Default value: 0)

Select the serial
communication

speed.

Basic  parameter
[Pr.PC21]
: 0020

Configure the 4-digit value of the default parameter for Pr.PC21 as shown below.

@D

[©) Select Serial | @ Select Response
Transmission Speed Latency

0 9600 BPS 0 | Null

1 19200 BPS 1| Valid

2 | 38400 BPS

3 | 57600 BPS

4 | 115200 BPS
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TOP 225 -
5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.
(The cable diagram described in this section may differ from the recommendations of “MITSUBISHI Electric Corporation”)

W RS-422 (1:1 connection)

COM PLC
Pin Signal Pin Cable connection Pin Signal Pin
arrangement*Note 1) name number number name arrangement Note 1)
1 5 RDA 1 Y 1 LG I
Q o 3 3 RDP .qullT
6 9 8
RDB 4 4 SDN
Based on Based on
_— SG 5 5 SDP o
communication communication
cable connector SDA 6 6 RN cable connector
front, ! ! LG front,
D-SUB 9 Pin male 8 8 TRE 8-pin male RJ45
(male, convex) SDB 9 » (Male, convex)
*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
W RS-422 (1:N connection) — Refer to 1:1 connection to connect in the following way.
TOP . . o MELSERVO Cable connection and signal MELSERVO
————— Cable connection and signal direction - o -
Signal name Signal name direction Signal name
RDA Y 1 LG 1 LG
RDB 2 P5 2 P5
SDA 3 RDA 3 RDA
SDB 9 . 4 SDB 4 SDB
SG 5 SDA 5 SDA
6 RDB * 6 RDB
7 LG 7 LG
8 TRE 8 TRE
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6. Supported addresses

The devices available in TOP are as follows:
The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address
range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Device Bit Word Remarks

Bit Device
SP SPO - SP6 -

Servo amplifier request
SPO: Clear status display data
SP1 : Reset current alarm

SP2: Clear alarm history

- Restrict or disable input devices (DI), external
analog input signal, and pulse train input excluding
the EM2 (force stop 2), LSP (forward rotation stroke
end), and LSN (reverse rotation stroke end)

SP3: (a) Restriction

SP5: (b) Disable restriction
- Restrict or disable output device (DO)

SP4: (a) Restriction

SP6: (b) Disable restriction

Note 1)

oM OMO to OM2 -

Operation mode selection
OM4 - OM5

READ: Test operation mode

Read test operation mode

0000: Normal mode (Not a test operation mode)

0001: JOG operation

0002: Positioning operation

0003: No motor operation

0004: Output signal (DO) forced export
WRITE: Select operation mode

Switch operation mode

0000: Disable test operation mode

0001: JOG operation

0002: Positioning operation

0004: Output signal (DO) forced export

™8 TMB1 - TMB6 - Instruction demand

- Used when paused during a test operation
(positioning operation)

TMB1: Pause

TMB5: Resume remaining length

TMB6: Clear remaining length

TMB2: Start command for test operation
(positioning operation)
- Select positioning direction for test operation
(positioning operation)

TMB3: Forward rotation direction

TMB4: Reverse rotation direction
Note 1)
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Device Bit Word Remarks
oTl OTIO - OTI5 - OTIO - One-touch tuning command
OTI1 - One-touch tuning start command(Basic mode)
OTI2 - One-touch tuning start command(High mode)
OTI3 - One-touch tuning start command(Low mode)
OTI4 - One-touch tuning start command
OTI5 - Return to initial value
OTI6 - Return to value before adjustment
Note 1)
Word device
PA PA1.00 - PA32.31 PAT - PA32(RAM) Basic setting parameter
PA1001.00 - PA1032.31 PA1001 -
PA1032(EEPROM)
PB PB1.00 - PB64.31 PB1 - PB64(RAM) Gain filter parameter
PB1001.00- PB1064.31 PB1001-
PB1064(EEPROM)
PC PC1.00 - PC80.31 PC1 - PC80(RAM) Extension setting parameter
PC1001.00- PC1080.31 PC1001-
PC1080(EEPROM)
PD PD1.00 - PD48.31 PD1 - PD48(RAM) 1/O setting parameter
PD1001.00 - PD1048.31 PD1001 -
PD1048(EEPROM)
PE PE1.00 - PE64.31 PE1 - PE64(RAM) Extension setting No.2 parameter
PE1001.00 - PE1064.31 PE1001 -
PE1064(EEPROM)
PF PF1.00 - PF48.31 PF1 - PF48(RAM) Extension setting No.3 parameter
PF1001.00 - PF1048.31 PF1001 -
PF1048(EEPROM)
PO PO1.00 - PO32.31 PO1 - PO32(RAM) Option unit parameter
PO1001.00 - PO1032.31 PO1001 - PO1032
PL PL1.00 - PL48.31 PL1 - PL48(RAM) Linear servo motor/DD motor setting parameter
PL1001.00 - PL1048.31 PL1001 -
PL1048(EEPROM)
PT PT1.00 - PT48.31 PT1 - PT48(RAM) Positioning control parameter
PT1001.00 - PT1048.31 PT1001 -
PT1048(EEPROM)
ST ST0.00 - ST48.31 STO - ST48 Status display
Note 2)
AL AL0.00 - AL1.15 ALO - AL1 Alarm (current alarm compatible with J3)
AL11.00 - AL25.15 AL11 - AL25 Note 2)
AL AL200.00 - AL205.15 AL200 - AL205 Alarm (alarm history compatible with J3)
AL210.00 - AL215.15 AL210 - AL215 Note 2)
AL230.00 - AL235.15 AL230 - AL235
ALM ALMO0.00 - ALM1.15 ALMO - ALM1 Alarm (current alarm, extended for J4)
ALM11.00 - ALM59.15 ALM11 - ALM59 Note 2)
ALM ALM200.00 - ALM215.15 ALM200 - ALM215 Alarm (alarm history, extended for J4)
ALM220.00 - ALM235.15 ALM220 - ALM235 Note 2)
ALM240.00 - ALM255.15 ALM240 - ALM255
POS POS1.00 - POS255.31 POS1 - Point table (position)
POS1001.00 - POS1255.31 POS255(RAM)
POS1001 -
POS1255(EEPROM)
SPD SPD1.00 - SPD255.31 SPD1 - Point table (speed)
SPD1001.00 - SPD1255.31 SPD255(RAM)
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TO,

Device Bit Word Remarks
SPD1001 -
SPD1255(EEPROM)
ACT ACT1.00 - ACT255.31 ACT1 - Point table (acceleration time constant)
ACT1001.00 - ACT1255.31 ACT255(RAM)
ACT1001 -
ACT1255(EEPROM)
DCT DCT1.00 - DCT255.31 DCT1 - Point table (deceleration time constant)
DCT1001.00 - DCT1255.31 DCT255(RAM)
DCT1001 -
DCT1255(EEPROM)
DWL DWL1.00 - DWL255.31 DWLT1 - Point table
DWL1001.00 - DWL1255.31 DWL255(RAM)
DWL1001 -
DWL1255(EEPROM)
AUX AUX1.00 - AUX255.31 AUX1 - Point table (auxiliary function)
AUX1001.00 - AUX1255.31 AUX255(RAM)
AUX1001 -
AUX1255(EEPROM)
MCD MCD1.00 - MCD255.31 MCD1 - Point table (M code)
MCD1001.00 - MCD1255.31 MCD255(RAM)
MCD1001 -
MCD1255(EEPROM)
MD MDO0.00 - MD11.15 MDO - MD11 Machine diagnosis data
oTsS OTS0.00 - OTS3.15 OTS0 - OTS3 One-touch tuning data
DI DI0.00 - DI6.15 DIO - DI6 External input
DO DO0.00 - DO4.15 DOO0 - DO4 External output
Note 2)
DOUBLE WORD DEVICE
LD LD0.00 - LD1.31 LDO - LD1 Current position latch data
Note 2)
RR RR1.00 - RR4.31 RR1 - RR4 The value of the general purpose register
RR1001.00 - RR100.314 RR1001 - RR1004
RD RD1.00 - RD4.31 RD1 - RD4 The value of the general purpose register
ALD ALDO0.00 - ALD1.31 ALDO - ALD1 Lifetime diagnosis
™I TMIO0.00 - TMI2.31 TMIO - TMI2 Input signal for test operation (for test operation)
Note 1)
T™MO TM00.00 - TMOO0.31 TMOO0 Forced output of signal pin (for test operation)
Note 1)
TMD TMDO0.00 - TMD1.31 TMDO - TMD1 Set data (for test operation)
TMD3.00 - TMD3.31 TMD3 Note 1)

Note 1) Write-only
Note 2) Read-only
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